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OVERVIEW  

 
MineVent is a greatly enhanced version of the Penn State ventilation package which formerly ran in batch mode from 

data cards. The Penn State package had two major deficiencies, the input is very labor intensive and the output is 

available only in tabular form.   

 

MineVent runs within AutoCAD and has pull down menus, toolbars and most of the information can be entered with 

the mouse or the digitizer puck. The preferred method for defining the ventilation network is to work from as-mined 

and projections maps from your AutoCAD drawings. The nodes are picked up from the maps and because they are to 

scale, the system can automatically compute the length of each branch. The network can also be digitized from a 

hardcopy map of the mine, but the process is somewhat less convenient than working from the screen. 

 

The following figure is a diagram of the initial STARTUP menu which appears whenever the ICAMPS shortcut is 

executed.  All the ICAMPS modules, e.g. MineVent, MineSimU and MineWater can be accessed from this menu.  

 

 

 

 

 

 

  



 

 2 

 1. GENERAL NOTES AND WARNINGS   

 
OSNAPS AND Z-VALUES 

The osnap feature of AutoCAD can be used to select nodes, numbers and branches. If areas of the drawing are 

cluttered the wrong entity may be selected. Use the osnap feature with caution. In a previous version of MineVent 

selecting nodes with the osnaps ON caused errors in the node number being assigned the z-value.  If you have 

problems designating start and end nodes for a branch it could be that the node has the wrong z-value. The z-value of 

the node should be the node number. 

 

 DIGITIZER  
Working with a screen and mouse or a digitizing pad and puck are very similar operations. Both methods snap on to 

points selected with the cursor and/or keyboard.  If you make use of the AutoCAD digitizing template, data entry can 

be limited to alphabetic information. See the AutoCAD instructions on setting up the digitizer template to match the 

screen. If you have sufficient floor space, to position the digitizer tablet more or less horizontally, the screen and 

keyboard can be placed on the tablet for easy viewing and access. Always check the screen to be sure that the proper 

point or data has been entered. 

 

 NON-GRAPHICAL/INTERACTIVE METHODS  
 

MineVent has provisions to accept data in free format tabular form. For example, you can key a list of nodes in free 

format in the following sequence: node number, X coordinate, Y coordinate and use spaces to delineate each 

parameter. The file created should have a file type of ".NOD". Use the Read Node File option in MineVent to read this 

node file into your current drawing.  

 

 DELETING NODES AND BRANCHES  

 

Never use the AutoCAD erase command to delete nodes and branches.  Both are entities with associated attribute 

blocks and the AutoCAD erase command does not recognize these associations. If you use the AutoCAD erase 

command to delete a branch or node, you likely will be left with a corrupted drawing which is difficult to correct. 

Specifically the nodes are stored in a file called node.dat stored in the drawing directory. 

 

 

AVOID THE WBLOCK COMMAND  

 

Never use the AutoCAD wblock command with MineVent drawings.  Using this command to extract the branches 

will cause the handles of the polylines to change and the program will no longer know which attribute block goes with 

which polyline. 

 

OPENING MORE THAN ONE DRAWING AND THE SDI VARIABLE  

 

When working with MineVent drawings you should only have one drawing open at a time.  Otherwise the node.dat 

file mentioned above will become corrupted between the two drawings and you will get duplicate nodes which can 

cause a multitude of problems.  When any ICAMPS shortcut is invoked it will set the Single Document Interface 

(SDI) variable to 1, which limits you to only opening one drawing at a time. If you need to open more than one 

drawing in regular AutoCAD you can type SDI at the AutoCAD command prompt and set this variable back to 0. As 

long as the SDI variable is 0 or 1 the user can change it, but if it is 2 or 3 then that means that AutoCAD has determined 

that there are applications loaded that require only one document to be opened.  In most cases you can set the SDI 

variable to 0 and open more than one drawing while in MineVent but you should be careful not to use the MineVent 

functions while having more than one drawing open. 
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 AUTOCAD COMMAND ABBREVIATIONS IN MINEVENT  

 
a             draw arc by three points  

aa            edit attributes one at a time  

ap            edit attributes one at a time  

av            edit attributes one at a time  

b             break  

c             draw circle by two points or key - in diameter or radius  

ch            change  

cf            chamfer  

cr            color  

cy            copy  

d             dimension  

DD            edit definition block  

dd            edit definition block  

ds            distance between two points  

er            erase  

ex            extend  

f             draw fillet  

h             draw cross - hatch  

i             insert block  

l             draw line  

la            change layer settings  

lf            freeze layer  

li            line information  

lo            layer off  

ls            layer set  

lt            thaw layer  

m             move  

m1            move to another layer  

o             offset  

p             draw polyline  

pe            polyline edit  

r             redraw  

rg            regenerate  

rt            rotate  

CR            change current layer color  

s             save  

sc            scale  

t             trim  

tx            insert text  

vd            delete view  

vr            restore view  

vs            ave view  

za            zoom all  

zd            zoom dynamic  

ze            zoom extents  

zp            zoom pr evious  

zw            zoom windows  
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PENVENT MODEL BUILDING GUIDELINES  

 

 Regulators 

 

The recommended procedure for modeling a regulator in an airway is to create a separate Regulator branch for the 

regulator in series with the branch representing the airway. Assign the minimum allowable resistance to the branch 

representing the regulator. When you run the PenVent program, it will limit the flow through this branch by assigning 

a high resistance to this branch. Run the List Pressure Drops option to display the required resistance. You will notice 

that most, if not all, branches will show a slight difference between the theoretical branch resistance (RR) indicated  

by the branch flow quantity and pressure drop and the resistance (BR) based on the input data. These differences are 

due to closure error in the calculations being limited by the Correction Factor. They usually have no significant effect 

on the network flow analysis, and can be reduced by using a smaller Correction Factor. The trade off is the number of 

iterations required for the network analysis to converge will increase, and some networks may not converge if the 

Correction Factor is set too low.  

 

 

 Injecting Gas 

 

Dummy branches are used to simulate gas entering the mine. These branches must begin at an atmospheric node and 

you must specify the quantity of gas and the gas concentration expressed as a percentage. After you run the PenVent 

program, use the Draw Gas Output option to display the quantity of gas flowing in the branches. 

 

 

 Natural Ventilation Pressure 

 

Natural ventilation pressure (NVP) is frequently inserted at a branch that begins or ends at an atmospheric node, but 

NVP can be inserted anywhere in the network by specifying a pressure when you define a branch.  NVP usually is not 

an important consideration and can be ignored. If it is ignored, and the model indicates that working face at 

significantly different elevations are at approximately the same absolute pressure and they are connected via one or 

more branches, NVP should be inserted in the ventilation network model.  In such cases, including the NVP might 

indicate a flow reversal at one of the faces.  The pressure must be stated in inches of water gauge for the English units 

version and pascals for the metric version. If the NVP assists the flow, it is positive and negative otherwise.  

 

 

 Sizing Fans 

 

Normally your network will contain one or more Fan Branches. If you do not have fan curve data, the fan branches can 

be replaced with Fixed Quantity Branches. You can vary the quantity in such branches to determine the flow through 

the fans that is required to achieved acceptable flow quantities through the mine. The pressure drop across  these 

Fixed Quantity Branches indicates where the fan must operate. This data can be compared to existing or proposed fans 

to determine the required size and operating points for the fans.  

 

 

 Inputting Fan  Data 

 

Experienced ventilation engineers realize that ventilation survey data cannot be very precise, but small errors in 

branch data do not significantly impact the analysis of a ventilation system. However, since all the air passes through 

the fan branches, the fan curve data should be entered as accurately as possible. Do not round off the coordinates taken 

from the fan curve, for example if the quantity coordinate is 232, use that number, not 230. This small difference can 

result in a solution to the ventilation network analysis that is not on the fan curve. It also is a good practice to check 

your fan curve input data by plotting the data points with graphing software such as a spreadsheet. The points should 

be on a smooth curve. The PenVent program uses a mathematical function to convert the fan curve data to a sequence 

of points that appear at the beginning of the DRAWING NAME.OUT file. Plot this data and look for any irregularities 

in the curve. The fan data curve must be consistent without any abrupt variations in curvature or squiggles in the plot. 
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2.  MINEVENT MENU  
MineVent has pull-down menus and icon toolbars as shown below. The first three headings on the left (Tools, Edit and 

Display) contain some useful AutoCAD commands.  The main MineVent features that are most commonly used are 

the Node Menu, Branch Menu and Output Menu.  The Symbols menu consist of annotation drawings such as fans, 

regulators, title blocks etc..  The Setup menu contains options for changing drawing coordinates and other useful 

utilities. The File Menu contains options for manipulating files and menus. All of these options will be discussed in 

detail later. 

 

 
 

 

 

The icons correspond to the following functions: 

 

Insert Node | Define Branch | Modify Branch | Create Penn  |  Draw Q&P  |  List Pressure  |  List Quantity  

 

        

 

 

 

 

 

List Pressure Drop  |  Color Branches by Q, Air Hp, Gas, Resistance or NVP 
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The contents of the first three Pull-Down commands follow: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.1 Tools Menu 

 

The Tools menu is mainly used for on-the-go osnapping.   For example, if the osnaps are OFF and you want to 

quickly snap to an intersection you can just go to Tools-->INTersec and then snap to the intersection then osnaps are 

turned back off so that it is a quick one time use of osnaps.  If you want to make osnaps "permanent"  then select 

OSNAP first and then the desired snap mode.   For example if you are entering several nodes and need to snap to 

intersections then select OSNAP first and the select INTersec. To turn osnaps back off then select OSNAP then 

NONE. 

 

The other useful features of the Tools menu is the Cancel command, Undo, Redo, and Redraw.  A word of caution is 

that you should be very careful using Undo and Redo in MineVent drawings.  If you erase a node with the MineVent 

Erase Node command and then do an undo you may end up with a node that is in the drawing but not in the node file 

which can cause duplicate nodes and other issues.   So it is highly advised that you do not use the Undo and Redo 

unless you know that you are working on parts of the map that have no affect on MineVent entities such as nodes, 

attribute blocks, branches and arrows. 

 

 

2.2 Edit Menu 

 

The Edit menu has several useful AutoCAD commands. As noted earlier you should be careful with the Erase 

command as well as the copy command when working with MineVent entities.  The rest of the commands here can be 

used with relative safety.  Of course you do not want to delete any of the MineVent layers such as Intake*, Faces, 

Gobs, Return*, Leak*, or Vent* (where the * implies other letters and numbers).   Also you should never Explode 

any MineVent entities namely nodes or branches unless you know what you are doing and have a good reason to do so. 

 

 



 

 7 

2.3 Display Menu 

 

The Display menu has the most commonly used Zooming and Panning features of AutoCAD. As well as a menu 

option called Drawing Aids which is essentially the AutoCAD Drafting options dialog box where you can change 

grids, snap modes, polar tracking and more.  The last option on this menu is called Modify Layer and can be used to 

access the AutoCAD layer manager where you can turn on and off layers, freeze them, set the current layer, set layer 

colors and other options depending on your version of AutoCAD. 
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3: NODE MENU 
The Node Menu options allows you to create or modify the node data. The following pull down menu appears when 

you select this option.  

 

 

3.1  Digitize/Enter Nodes 
Ventilation nodes, hereafter referred to as nodes, can be digitized directly from an AutoCAD drawing of the mine 

layout. If you do not have the map on the computer, the nodes can be selected off a hardcopy by using a digitizer. The 

program will work interactively with the digitizer or the nodes can be digitized into a data file which can be loaded into 

MineVent. You must identify every active node, that is, nodes where pressure is to be measured. You also have the 

option to enter dummy nodes. You do not have to enter a node everywhere the branch changes direction. You can just 

pick a point "out in space" , by left clicking, which can also be called a dummy node although really it is not a node at 

all. Use a different numbering series for the dummy nodes to avoid mistaking them for active nodes, for example, 

number all active nodes from 1 through  699 and the dummy nodes 700 or larger. The system currently accepts up to 

500 nodes.  When you choose this option the following command line prompt appears.  

 

Enter Node/<R> to End 
 

Left click on a node location. Caution: If you are working on a multi-level drawing, every node must be within 

one of the level boundaries. After you pick the node location, you are prompted for the node number. 

 

Type Node ID <1> 

 

You can enter a node number of your own choosing or let the program assign a default value. Except for nodes 

assigned the number 1, which represents the atmosphere, each node must have a unique number. If you enter a 

duplicate node number, the following message appears. You must re-enter a non-duplicate node number to proceed or 

hit escape (Esc) to pick another location or hit Esc twice to cancel the digitize node command completely. 

 

Duplicate nodes not allowed, please re-enter node number. 

 

When you begin a session, the default is the highest number in the drawing plus one. If you are modifying an existing 

network drawing, a lower unassigned numbers may be available; see Option 3.8, List Unused Nodes, for a list of 

available node numbers. If you assign one of these unused node numbers, the default for the next node will be the next 

higher unused node number. 
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The system allows atmospheric nodes at multiple locations to eliminate the need for connecting all the atmospheric 

airways to one point. You should assign number 1 only to the atmospheric node, since this is the only number for 

which the automatic duplicate node checking is disabled. When entering Node # 1, you will always get the following 

prompt: 

Warning: Node # 1 is not checked for duplication 
 

The system places the node number next to the node. The node can be re-positioned with the AutoCAD move 

command and thereafter it will appear in the selected location.  To move only the node number you can use 

Output-->Edit Schematic and select the Move Attribute button and select the number (not the circle!).  

 

NOTE: Frequently you want to see the coordinates of nodes as they are entered. If the coordinates are not displayed 

(on the lower left of the screen in the status bar for most versions of AutoCAD) as you move the cursor, right click on 

the coordinates in the status bar to turn on the Coordinates Display function.  

 

3.2 Move Nodes 

Use this option only to move nodes which are not connected to branches. If a branch is connected to the node, use 

Option 4.4, Move Multiple Branches. Another alternative is to delete the branches which are connected to the node, 

move it and then recreate the branches. When you select this option the following command line prompt appears: 

 

Select objects: 

 

Position the pick box on the circle, node number, or pressure value and click the left mouse key hit the enter key once 

after selecting the node and drag the node to the desired position. You can actually move more than one node at a time  

by picking several nodes at the Select objects prompt, but this is not recommended unless you are careful.  Note: To 

change the size of the pick box you can type pickbox at the AutoCAD command prompt. 

 

 

3.3 Find Node 
This option helps you locate a specific node in the drawing. The following dialog box appears: 

 

 

If you enter an existing node number, a green arrow will appear at the node location and the coordinates will shown on 

the status bar. The following prompt will appear allowing you to either stay zoomed in to the node that was found or 

zoom back to the previous view. 

  

 Zoom Previous (Yes/No) <Yes>: 

 

If you entered node 1, all location of node 1 will be marked pausing after each find with the zoom previous option. You 

can then note the coordinates in the status bar. 

 

If the node number you entered does not exist, the following message appears: 

 

Node not found 
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3.4 Erase/Delete Nodes 

Use this option to delete a node. Do not use the AutoCAD erase command to erase nodes as this will not update the 

node.dat file. When you select this option, the following command line prompt appears: 

 

Select objects:  
 

Important:  If you delete a node, any branch which depends on that node will not be deleted. You must also delete that 

branch or the Penn State program may give you results that you do not expect as it only uses the data for the nodes that 

are found in the branch blocks. 

 

 

3.5 Check for Duplicates 

Select this option to check for duplicate nodes in the drawing.  Duplicate nodes can cause problems with the Penn 

State program especially if they have branches connected to them. 

 

If the program finds a duplicate node it will report on the AutoCAD command prompt as 

 

 Checking the drawing for duplicate nodes... 

 Node 1 not checked for Duplicates. 

 Duplicate Node found X 

 

Where X represents the duplicate node number. Press F2 on the keyboard to see the AutoCAD text screen and make 

sure to see the whole list of duplicate nodes because there may be more than one. 

 

If no duplicate nodes are found in the drawing you will get the following message on the AutoCAD command 

prompt/screen: 

 

 Checking the drawing for duplicate nodes... 

 Node 1 not checked for Duplicates. 

 No Duplicate Nodes found. 

 

It would not be a bad idea to occasionally check for duplicate nodes, especially if you are having problems. If you do 

find duplicate nodes you would also want to check for duplicate branches as well as branches that may be connected to 

duplicate nodes. 

 

 

3.6 List Nodes 

Select this option to display the existing node numbers. All nodes in the drawing will appear. Use Option 3.7, List 

Unused Nodes to list any unreferenced nodes, that is, nodes which are not connected to branches. Each node number 

and its X ,Y and Z coordinates will appear in a dialog box list as shown in the following example. The Z coordinate 

should always be the same as the node number. It also gives you the opportunity to print the list to a printer or a file 

(printing issues are discussed later in the List Branches option).  You can also use this function to find and view nodes 

on the list in the drawing, which has the essentially same effect as the Find Node menu option, in case you would 

rather find it from the list than by typing in a number. This feature is useful for verifying that the node coordinates are 

reasonable. 
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3.7 List Unused Nodes 

Select this option to display the unused node numbers. Nodes that are in the drawing but not connected to any branch, 

called unreferenced nodes appear on the left and node numbers that are not assigned to any node are on the right as 

shown in the following example. You can delete all the unreferenced nodes or to print the list to a printer or file.  
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3.8 Write Node File 

This option is very useful when the node data need extensive editing. The following command line prompt appears 

when you select this option: 

 

Enter Node data file to Write <DWGNAME .NOD> 
 

The program will create a new file designated as <DWGNAME>.NOD  where <DWGNAME>  is the name of the 

drawing file you are currently working on. It is recommended that you enter a name that you know exactly where it is 

and the name of the file. This new file can be edited with a full screen editor. After the <DWGNAME>.NOD  file is 

corrected it can replace the original data using Option 4.7, Read Node File. This option will write all the occurrences 

of Node # 1 into the node file. 

 

3.9 Read Node File  
This option is used to load nodes into the drawing from <DWGNAME>.NOD  file.  Nodes already in the drawing 

will be flagged as duplicates and skipped. The following command line prompt appears when you select this option: 

 

Enter the Node File Name:> 

 

The input file can be in free format but the data must be in the following sequence node number, X coordinate, Y 

coordinate. The list of nodes is checked for duplicate node numbers as they are read. Whenever the system reads 

Node #1, it will display the following prompt:  

 

Node # 1 not checked for duplication 

 

3.10  Multiple Levels 
Where the ventilation network involves nodes and branches that are on more than one level or seam, the plan view of 

the mine layouts usually overlap. The drawing setup must be modified to allow simultaneous viewing of the 

corresponding ventilation schematics without any overlap. To allow such viewing the schematics are displaced 

horizontally and/or vertically from their true positions. Since MineVent calculates the length of branches from the X 

and Y positions of the branch vertices, the system needs information about the schematic displacements and elevation 

of the mining levels and the atmospheric nodes. The displacement and elevation information is input through the 

following dialog box which is accessed under the Node pull-down menu. 
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Add: This option is used to add a new seam or level to the list. The maximum is four. Fill in the edit boxes below the 

list with the name and offset distance and click this button to add it to the list. 

 

Delete: This option is used to delete a level from the list. 

 

Change: This option is used to change the information about a level in the list. Fill in the edit boxes below the list with 

the name and offset distance and click this button to change it in the list. 

 

Show: This option is used to display the selected level enclosed by a green box.  

 

Print : This option is used to print the level information in the list to a printer or a file. Printing issues are discussed 

later in the List Branches option. 

 

Select Pts. This option is used to select the Level Boundaries for the origin level. The boundaries for all other levels 

will be calculated from the origin level boundaries and the displacement coordinates. 

   

The system allows for four levels, one of which is the ground surface. The drawing is divided into four quadrants 

which are referred to as levels numbered from 0 to 3 in the dialog box. Level 0 is located in the lower left quadrant of 

the drawing, Level 1 is on the lower right and Level 2 is on the upper left. Level 3 is reserved for the ground surface 

terrain model and placed in the upper right quadrant. Normally Level 0 would correspond to the top most mine level. 

The next level would be to its right, and the lowest mine level is drawn in the upper left quadrant. 

 

The level names can be specified by the user. In the above example, the levels have been arbitrarily assigned the names 

origin for level 0, level1for level 1, level2 for level 2 and surface for level 3. 

 

You must also specify the X (horizontal) distance that the drawings on level 1 and 3 have been displaced from their 

original positions. Likewise you must specify the Y (vertical) distance the drawings on level 2 and 3 have been 

displaced vertically. The elevation values are the average elevation of each of the mining levels and a default value for 

the ground surface elevation. You must also provide the lower left and upper right boundaries for the drawing at Level 

0. You can do this by using the Select Pts button, windowing around the area that you want to designate as the level 0 

dimensions or boundaries and then hitting the Change button to save the values. Note: You must hit the Change 

button after selecting the origin boundary points, otherwise the information is not updated. The system adds the 

displacements to the Level 0 boundaries to determine the boundaries of the other levels. After you enter the above 

data, click the OK  button to save the data.  

 

You define branches by picking points on the drawing that correspond to the actual airway path and a branch may have 

many vertices between the beginning and ending nodes. However, all nodes, numbered or where airways change 

direction, must be within one of the level boundaries. 

 

The system calculates the branch lengths by using the above information and the X,Y coordinates from the drawing. 

The Z coordinate of the atmospheric nodes will be computed from the surface contours on a ground terrain drawing in 

the level 3 quadrant. This must be on a layer called VCONTOUR. You must use the AutoCAD XREF command to 

insert the terrain drawing into your schematic drawing. See the end of section 7 for instruction on using that 

command. If no terrain drawing is provided, the Z coordinate of the atmospheric nodes defaults to the elevation given 

for the Level 3 quadrant. You can always over ride the map or default value. 

 

3.11 Switch to Level 

This option lets you move the schematic for a level to the center of the screen. When the schematic requires multiple 

levels the drawing can become very large and viewing all levels simultaneously often is not practical. When you select 

this option, the following dialog box appears. 
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 4: BRANCH MENU  
The Branch menu allows you to create or modify the branches, branch data, resistance data and defaults.  The 

following pull down menu appears when you select this option.  

 

4.1 Define New Branch 

You can create a ventilation diagram with up to 4000 branches (and up to500 nodes). When you select this option the 

following dialog box appears. You can create new branches as well as modify any of the branches you have created 

within the same Define New Branch session. 
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To create a branch, fill in the edit boxes on the left. The branch name is limited to 25 lower case or 19 upper case 

characters. The branch type names indicate their application, except that dummy branches are used to inject gas into 

the system. After you select the branch type and code, data can be entered for the relevant parameters. Take the zero 

default for quantity except for fixed and limited quantity and dummy branches. For most applications the natural 

ventilation pressure can be ignored; if otherwise, input the natural pressure. Enter the resistance if known, otherwise 

use Calculate R.  However, the calculation resistance function will not execute until the airway path has been 

specified. Click the Pick Nodes/Add Branch button to select the nodes for the branch. 

 

Name: The name can be twenty five characters long but only 19 lower case and 15 upper case characters will be 

displayed. 

 

Type: Select the branch type from the drop down list.  

 

Note: If you select the Regulator branch type then the labels for the dialog edit boxes changes from C Value to Height 

Max and from Fan Ref to Width Max which are used in the regulator resistance calculation. 

 

Code: Select the code from the drop down list. Code names and associated default information, line type and color 

information can be set using Configure Branches. 

 

Quantity : The quantity flowing in the branch must be specified for Fixed and Limited Quantity type branches. A 

quantity must also be specified for Dummy branches which represent gas injected into the mine from the atmosphere 

(Node 1) to a non-atmospheric node. The Gas Concentration (Gas Cnt.) must also be specified for such branches. 

Quantities may be specified for other branch types but are only used as starting values in  iterative calculation 

procedure. 

 

NVP:This parameter is used to represent Natural Ventilation Pressure (NVP).  Frequently these branches will start or 

end at an atmospheric node, but any branch in the network can have NVP. The units are inches of water gauge in the 

english version and pascals in the metric version.  

 

C Value: This parameter is the exponent of the quantity factor in the resistance equation for leakage branches. The  

coefficient of the pressure variable is assumed to be one. 

 

Fan Ref: This number applies to fan branches and corresponds to the a fan curve in the .FAN file which you specify  

for this application. The number here should match the fan reference number of the fan curve you want to use. 

 

Gas Cnt.: The gas concentration for gas injection with Dummy branches. 

  

Resist: You can specify the branch resistance but in most cases you will use the Calculate R function to compute the  

branch resistance from the 9 available formulas. Note that the Non Equal Branches in series formula has been  

disabled.   

 

>Pick Nodes/Add Branch<: When you click this button, the following command line prompts appear. 

  

 Pick Start Node/<R> to end 
 

 You must have previously defined the start node. If you cannot find the desired node, use the Find Node 

 option to locate the node. After you pick the start node, the command line prompt changes to the following.  

 

 Pick [End Node/Dummy Node]/<R> to end 

 

The branch must end at a node you previously defined, but the line representing the branch can follow the 

actual air flow path. Pick the points (called dummy points) where the airway changes direction in the order 

in which they will be connected.. After you pick a point, the node number (0 for dummy points) and its 

coordinates appear in the command line after the prompt. After you pick each point, the above prompt 

reappears and a line will be drawn between the points you pick. 
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CAUTION : If you are working with a multi-level drawing, all intermediate nodes and vertices where the 

airways change direction, must be within one of the level boundaries. 

 

The End node must be one of the active nodes you previously defined. After you pick the End node press the 

Enter key to indicate the end of the branch.  

 

Note: If you are defining several branches you may want to set up AutoCAD to associate the right mouse 

button with the Enter key. This will save you time from constantly having to hit Enter on the keyboard and 

you can define all your branches just using the mouse. To set this type config at the AutoCAD command 

prompt select the User Preferences tab, click the Right Click Customization button and then select the Turn 

on Time Sensitive Right Click checkbox.  This may vary on different versions of AutoCAD or it may 

already be set. 

 

When you indicate the End node has been picked, the new branch will appear highlighted at the bottom of 

the list. If you indicate the true airway path, the length of the airway can be calculated and used in the 

resistance calculation.  If you did not enter the branch resistance, the resistance will be a default value. Use 

the Calculate R option to calculate the resistance and it will update the resistance in the listing. 

 

Calculate R: When you click the Calculate R button, the following dialog box appears.  

 

This option uses formulas to determine the resistance. Select a formula that is appropriate for the branch type/code 

combination being defined. After you select a formula, only the applicable parameters in the box will be highlighted. 

For a new branch the parameters contain the code defaults as indicated by the Code button under Defaults By option 

and the message "Branch CODE DEFAULTS shown" appears at the bottom of the dialog box. The parameter values 

correspond to the code default values you entered in the Configure Branches option. If you are computing the branch 

length from survey data, the branch length is not used in the calculation. 
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If you edit a previously defined branch, the Default By: option changes to Previous. You can change any of the 

highlighted parameter values. The branch length is automatically calculated from the branch polyline, but you have 

the option to change the length if necessary. The message at the bottom of the dialog box changes to "Previous 

resistance defaults shown: Branch Length = Previous Length". 

 

The PresQuan and SURVEYED formulas apply if you know the pressure and quantity in a branch. After  you have 

done a ventilation survey, you can enter the survey data one branch at a time using PresQuan or you can use the 

SURVEYED formula with existing files or create files of the surveyed pressures and quantities. The pressure data is 

stored in a file you designate as <DWGNAME.P> which has the format (node number, pressure) and the quantities are 

stored in a file <DWGNAME.Q> which has the format (start node number,  end node number, quantity).The 

program searches the .Q file for the node combination which matches the branch you are entering. If the branch is in 

the .Q file, the program then looks for the surveyed node pressures in the .P file and computes the branch resistance.  

 

The formula NE B-S: n None Equal Branches in Series has been disable because such branches are difficult to modify. 

If you have a situation where non-equal entries are in series, create a separate branch for each segment in the series. 

 

When you select the NE B-P : n Non Equal Branches in Parallel formula, you must indicate the number of  branches 

(entries) and then click the OK button. The following dialog box will appear, once for each of the entries.  

 

After you select the resistance formula for each branch, the required parameters and their default values will appear. 

The branch length is the length of the polyline. If the non-equal branches are not the same length, you can change the 

branch length for every entry. 

 

For single entry airways, click the None button under Use With and select one of the other formula options. For 

multiple equal entries in parallel you need to select one formula and set of parameter values. Click the EQ B-P radio 

button under Use With, select any of the single entry formulas, enter the parameter values and type the # of Entries.  

 

OK:  Click the OK button and the branch resistance will be calculated and appear in the Resist. edit box in        

the Define Branch dialog box. The minimum resistance accepted by the PenVent program is 0.0001.        

You will get an error message if the calculated value is too small. 

 

Color:  The color defaults to the color specified for the branch code, which is set in Configure Branches, but you can  

change the color with this option. The drop down list contains all the AutoCAD colors. By default the color is  

BYLAYER and the layer is that which is associated with the code. If you select a color other than the one associated  

with the code/layer the color will be associated with the polyline and not BYLAYER. It is recommended to color  

BYLAYER so that you can change all the colors by changing the color of the layer. 

 

Hide the quantity: In congested areas of your ventilation schematic you may want to hide the branch quantities of  

less important branches. If you check this  button, the quantity for this branch will not be displayed when you select  

Draw Quan/Pres Output. If you want to switch it back on, use the Modify Branch Parameters option below. 

  

 



 

 18 

Change/Update Branch: Any of the branches in the list can be edited. Highlight the branch by clicking on the 

corresponding line and the branch parameters will appear in the edit boxes on the left. After you make your changes, 

click the Change/Update button to save the changes. 

 

View Branch: Any branch in the list can be viewed. First highlight the branch you want to view and click the View 

Branch button. The ventilation diagram will be zoomed in where the branch is located with a green arrow pointing at 

the branch attribute box and its flow arrow. The command line prompt defaults to Zoom to the previous window. 

 

Delete: Any branch in the list can be deleted. First highlight the branch you want to delete and click the Delete Branch 

button. The corresponding branch will be deleted from the network. 

 

OK: Click OK to save all the branches in the list and make them a part of the ventilation network. You can erase them 

later if you need to. 

 

Cancel: Click Cancel to remove all the branches in the list, that were defined in the current Define New Branch 

session, from the ventilation network.  

 

CAUTION : Hitting cancel will delete all the branches that you have defined in the current Define New Branches 

session. You will not be ask if you are sure that you want to delete. 

 

4.2 Modify Branch Parameters 

When you select this option the following dialog box appears.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To start the process, click the Pick Branch Attribute Block button. The following command line prompt will appear: 
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Select Branch Attribute Block  

 

If you miss the block, the next prompt asks you to window around the block. If you have difficulty picking the branch, 

be sure that the window encloses the attribute block and the quantity (if shown). 

 

You can change any of the Branch parameters that are not grayed out. See the Define New Branch option above for the 

instructions to change the Branch Type, Code, Name, Color, Quantity, C Value, Fan Ref. #, NVP, Gas Cnt., Regulator 

Height and Width, Hide the quantity and Calculate R options. The other buttons provide the following options: 

 

Reverse Branch: Use this option to reverse the direction of the arrow and interchange the start and end nodes for a 

single branch. If you have run the PenVent program and want to reverse the flow direction for branches with negative 

flow, use Reverse Selected Neg Branches or Reverse All Negative Branches from the Output menu. 

 

Split Branch: This option allows you to insert a node into an existing branch. The two resulting branches will be of 

the same type and code as the original branch. You have the option to allow the program to assign automatically the 

resulting branch resistances in proportion to their lengths. 

 

CAUTION:  The system will not allow you to split a fixed or limited quantity branch because the Penn Vent program 

does not allow two fixed or limited quantity branches in series. Change the branch type before proceeding.  

 

When you select this option, the following command line prompts appear: 

 

         Updating Branch Data... 

Select split point for branch polyline (Snap Mode Required) 

 

Normally the required snap node is NEAr est.  After you select the split point the prompt is: 

 

Node Number for split point <number>:  
 

The default number is always one greater than the largest node number in the drawing. You can specify any unused 

node number. The next prompt is: 

 

Update the resistance for the new branches (Yes/No) <Yes>: 
 

If your schematic is drawn to scale, take the default and the resistance of the original branch will be allocated to the  

new branches in proportion to their lengths. If your schematic is not to scale, enter No and you will be prompted for  

each resistance as follows: 

 

Resistance from Start node to split 
and 

Resistance from split to end node 

After the resistance is entered, either automatically or manually, the next prompt gives you the option to redraw the 

schematic 

 

Redraw Updated drawing (yes/No) <N>: 
 

After you respond to the prompt, the following display box appears. After you click OK the Edit Branch dialog box for 

the first of the new branches appears.  



 

 20 

 

 

Merge Branch: This option allows you to combine two branches that are in series by removing their connecting node. 

Since more than two branches could be in series, the command line asks you to pick the attribute block for the second 

branch. If the branches are not of the same type, the resulting branch will be of the type and code of  the first branch 

that was picked. The resistance of the new branch will be the sum of their separate resistances. 

 

4.3 Erase/Delete Branch 

The Delete Branch option should be used to delete branches from the network. Never use the AutoCAD erase 

command to delete a branch. The AutoCAD erase command does not know that the branch line, arrow and attribute 

block are related. If you use the AutoCAD erase command to delete a branch, your drawing may be corrupted.  To 

delete a branch, position the cursor over the branch attribute block or branch quantity and press the left mouse button  

Erasing a branch does not affect the nodes the branch is connected to. It is not recommended to use the AutoCAD undo 

command to undo a deleted branch, but if absolutely necessary make sure to undo the polyline, arrow, attribute block 

and check the branch using the ddatte and list AutoCAD commands to make sure that the handles are correct.  

 

4.4 Erase Multiple Branches 

The Erase Multiple Branches option should be used to delete a group of branches from the network. Never use the 

AutoCAD erase command to delete branches. The AutoCAD erase command does not know that the branch line, 

arrow and attribute block are related. If you use the AutoCAD erase command to delete a branch, your drawing may be 

corrupted. To delete a group of branches, create a closed polygon around the branch attribute blocks you want to erase. 

The following prompts show on the command line.   

 

Create closed polygon: Pick Start Point: 

Pick Next Point/<RETURN> to Close: 

Pick Next Point/<RETURN> to Close: 

Pick Next Point/<RETURN> to Close: 

Pick Next Point/<RETURN> to Close: 

 

Erasing branches does not affect the nodes the branches are connected to. It is not recommended to use the AutoCAD 

undo command to undo an Erase Multiple Branch. 

 

4.5 Move Multiple Branches 

This option allows you to modify a network where the change involves moving a group of branches such as 

lengthening or shortening mains or a longwall panel. When you select this option, the command line will ask you to 

create a four sided window around the branches to be moved and then to drag the selected branches (making the main 

or panel longer or shorter). The coordinates of the moved nodes will be updated and the following command line 

prompt will appear. 

 

Update the resistance for the new branches (Yes/No) <Yes> 

 


